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À propos

You can share this PDF with anyone you feel could benefit from it, downloaded the latest version 
from: notepadplusplus

It is an unofficial and free notepad++ ebook created for educational purposes. All the content is 
extracted from Stack Overflow Documentation, which is written by many hardworking individuals at 
Stack Overflow. It is neither affiliated with Stack Overflow nor official notepad++.

The content is released under Creative Commons BY-SA, and the list of contributors to each 
chapter are provided in the credits section at the end of this book. Images may be copyright of 
their respective owners unless otherwise specified. All trademarks and registered trademarks are 
the property of their respective company owners.

Use the content presented in this book at your own risk; it is not guaranteed to be correct nor 
accurate, please send your feedback and corrections to info@zzzprojects.com
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Chapitre 1: Démarrer avec notepad ++

Remarques

Notepad ++ est un éditeur de code source gratuit (comme dans "free speech" et aussi 
dans "free beer") et le remplacement du Notepad qui prend en charge plusieurs 
langues. En cours d'exécution dans l'environnement MS Windows, son utilisation est 
régie par la licence GPL. (Extrait des pages officielles)

Notepad ++ offre plusieurs avantages aux développeurs. Ce n'est pas un énorme environnement 
de développement intégré, c'est simplement un éditeur de texte léger.

Il offre

mise en évidence de la syntaxe pour divers langages de programmation•
Fonction forte de recherche / remplacement utilisant une expression régulière et pouvant 
traiter des fichiers ouverts ou des dossiers donnés

•

numéros de ligne•
achèvement automatique et suggestion de paramètres•
multi-édition•
enregistrement macro et lecture•
différents thèmes de style•
commandes d' exécution multiples•
de nombreux plugins pour améliorer encore plus les possibilités•

Toutes ces fonctionnalités ont convaincu différents développeurs d’utiliser cet éditeur.

Versions

Version Date de sortie

Version 7.3.3 2017-03-08

Version 7.3.2 2017-02-13

Version 7.3.1 2017-01-17

Version 7.3 2017-01-01

Version 7.2.2 2016-11-27

Version 7.2.1 2016-11-20

Version 7.2 2016-11-02

Version 7.1 2016-10-16
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https://notepad-plus-plus.org/download/v7.3.3.html
https://notepad-plus-plus.org/download/v7.3.2.html
https://notepad-plus-plus.org/download/v7.3.1.html
https://notepad-plus-plus.org/download/v7.3.html
https://notepad-plus-plus.org/download/v7.2.2.html
https://notepad-plus-plus.org/download/v7.2.1.html
https://notepad-plus-plus.org/download/v7.2.html
https://notepad-plus-plus.org/download/v7.1.html


Version Date de sortie

Version 7.0 2016-09-22

Version 6.9.2 2016-05-18

Version 6.9.1 2016-03-28

Version 6.9 2016-02-22

Version 6.8.8 2015-12-10

Version 6.8.7 2015-11-27

Version 6.8.6 2015-10-29

Version 6.8.5 2015-10-19

Version 6.8.4 2015-10-16

Version 6.8.3 2015-09-04

Version 6.8.2 2015-08-20

Version 6.8.1 2015-08-04

Version 6.8 2015-07-21

Version 6.7.5 2015-03-10

Version 6.7.4 2015-01-10

Version 6.7.3 2015-01-01

Version 6.7.2 2014-12-27

Version 6.7.1 2014-12-21

Version 6.7 2014-12-14

Version 6.6.9 2014-09-07

Version 6.6.8 2014-07-27

Version 6.6.7 2014-06-24

Version 6.6.6 2014-06-13

Version 6.6.4 2014-06-04

Version 6.6.3 2014-05-18
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https://notepad-plus-plus.org/download/v7.html
https://notepad-plus-plus.org/download/v6.9.1.html
https://notepad-plus-plus.org/download/v6.9.1.html
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https://notepad-plus-plus.org/download/v6.8.8.html
https://notepad-plus-plus.org/download/v6.8.7.html
https://notepad-plus-plus.org/download/v6.8.6.html
https://notepad-plus-plus.org/download/v6.8.5.html
https://notepad-plus-plus.org/download/v6.8.4.html
https://notepad-plus-plus.org/download/v6.8.3.html
https://notepad-plus-plus.org/download/v6.8.2.html
https://notepad-plus-plus.org/download/v6.8.1.html
https://notepad-plus-plus.org/download/v6.8.html
https://notepad-plus-plus.org/download/v6.7.5.html
https://notepad-plus-plus.org/download/v6.7.4.html
https://notepad-plus-plus.org/download/v6.7.3.html
https://notepad-plus-plus.org/download/v6.7.2.html
https://notepad-plus-plus.org/download/v6.7.1.html
https://notepad-plus-plus.org/download/v6.7.html
https://notepad-plus-plus.org/download/v6.6.9.html
https://notepad-plus-plus.org/download/v6.6.8.html
https://notepad-plus-plus.org/download/v6.6.7.html
https://notepad-plus-plus.org/download/v6.6.6.html
https://notepad-plus-plus.org/download/v6.6.4.html
https://notepad-plus-plus.org/download/v6.6.3.html


Version Date de sortie

Version 6.6.2 2014-05-08

Version 6.6.1 2014-05-04

Version 6.6 2014-05-01

Version 6.5.5 2014-03-07

Version 6.5.4 2014-02-18

Version 6.5.3 2013-12-31

Version 6.5.2 2013-12-10

Version 6.5.1 2013-11-03

Version 6.5 2013-09-29

Version 6.4.5 2013-08-09

Version 6.4.4 2013-08-08

Version 6.4.3 2013-07-28

Version 6.4.2 2013-07-09

Version 6.4.1 2013-06-30

Version 6.4 2013-06-29

Version 6.3.3 2013-05-05

Version 6.3.2 2013-04-03

Version 6.3.1 2013-03-17

Version 6.3 2013-02-03

Version 6.2.3 2012-12-16

Version 6.2.2 2012-11-18

Version 6.2.1 2012-11-11

Version 6.2 2012-10-10

Version 6.1.8 2012-09-17

Version 6.1.7 2012-09-11
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https://notepad-plus-plus.org/download/v6.6.2.html
https://notepad-plus-plus.org/download/v6.6.1.html
https://notepad-plus-plus.org/download/v6.6.html
https://notepad-plus-plus.org/download/v6.5.5.html
https://notepad-plus-plus.org/download/v6.5.4.html
https://notepad-plus-plus.org/download/v6.5.3.html
https://notepad-plus-plus.org/download/v6.5.2.html
https://notepad-plus-plus.org/download/v6.5.1.html
https://notepad-plus-plus.org/download/v6.5.html
https://notepad-plus-plus.org/download/v6.4.5.html
https://notepad-plus-plus.org/download/v6.4.4.html
https://notepad-plus-plus.org/download/v6.4.3.html
https://notepad-plus-plus.org/download/v6.4.2.html
https://notepad-plus-plus.org/download/v6.4.1.html
https://notepad-plus-plus.org/download/v6.4.html
https://notepad-plus-plus.org/download/v6.3.3.html
https://notepad-plus-plus.org/download/v6.3.2.html
https://notepad-plus-plus.org/download/v6.3.1.html
https://notepad-plus-plus.org/download/v6.3.html
https://notepad-plus-plus.org/download/v6.2.3.html
https://notepad-plus-plus.org/download/v6.2.2.html
https://notepad-plus-plus.org/download/v6.2.1.html
https://notepad-plus-plus.org/download/v6.2.html
https://notepad-plus-plus.org/download/v6.1.8.html
https://notepad-plus-plus.org/download/v6.1.7.html


Version Date de sortie

Version 6.1.6 2012-08-16

Version 6.1.5 2012-07-07

Version 6.1.4 2012-06-24

Version 6.1.3 2012-05-28

Version 6.1.2 2012-04-26

Version 6.1.1 2012-04-18

Version 6.1 2012-04-10

Version 6.0 2012-03-26

Version 5.9.8 2012-01-05

Version 5.9.6.2 2011-11-13

Version 5.9.6.1 2011-11-05

Version 5.9.6 2011-10-31

Version 5.9.5 2011-10-23

Version 5.9.4 2011-10-11

Version 5.9.3 2011-07-24

Version 5.9.2 2011-06-05

Version 5.9.0 2011-03-31

Version 5.8.7 2011-02-01

Version 5.8.6 2010-12-19

Version 5.8.5 2010-11-24

Version 5.8.4 2010-11-14

Version 5.8.3 2010-11-02

Version 5.8.2 2010-10-11

Version 5.8.1 2010-09-28

Version 5.8 2010-09-22
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https://notepad-plus-plus.org/download/v6.1.6.html
https://notepad-plus-plus.org/download/v6.1.5.html
https://notepad-plus-plus.org/download/v6.1.4.html
https://notepad-plus-plus.org/download/v6.1.3.html
https://notepad-plus-plus.org/download/v6.1.2.html
https://notepad-plus-plus.org/download/v6.1.1.html
https://notepad-plus-plus.org/download/v6.1.html
https://notepad-plus-plus.org/download/v6.0.html
https://notepad-plus-plus.org/download/v5.9.8.html
https://notepad-plus-plus.org/download/v5.9.6.2.html
https://notepad-plus-plus.org/download/v5.9.6.1.html
https://notepad-plus-plus.org/download/v5.9.6.html
https://notepad-plus-plus.org/download/v5.9.5.html
https://notepad-plus-plus.org/download/v5.9.4.html
https://notepad-plus-plus.org/download/v5.9.3.html
https://notepad-plus-plus.org/download/v5.9.2.html
https://notepad-plus-plus.org/download/v5.9.0.html
https://notepad-plus-plus.org/download/v5.8.7.html
https://notepad-plus-plus.org/download/v5.8.6.html
https://notepad-plus-plus.org/download/v5.8.5.html
https://notepad-plus-plus.org/download/v5.8.4.html
https://notepad-plus-plus.org/download/v5.8.3.html
https://notepad-plus-plus.org/download/v5.8.2.html
https://notepad-plus-plus.org/download/v5.8.1.html
https://notepad-plus-plus.org/download/v5.8.html


Version Date de sortie

Version 5.7 2010-07-05

Version 5.6.8 2010-03-04

Version 5.6.7 2010-02-21

Version 5.6.6 2010-01-26

Version 5.6.5 2010-01-25

Version 5.6.4 2009-12-28

Version 5.6.3 2009-12-18

Version 5.6.2 2009-12-11

Version 5.6.1 2009-12-05

Version 5.6 2009-11-30

Version 5.5.1 2009-10-09

Version 5.5 2009-09-21

Version 5.4.5 2009-07-14

Version 5.4.4 2009-07-05

Version 5.4.3 2009-06-07

Version 5.4.2 2009-06-01

Version 5.4.1 2009-05-27

Version 5.4 2009-05-25

Version 5.3.1 2009-03-29

Version 5.3 2009-03-08

Version 5.2 2009-02-08

Version 5.1.4 2009-01-12

Version 5.1.3 2008-12-29

Version 5.1.2 2008-12-14

Version 5.1.1 2008-11-11
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https://notepad-plus-plus.org/download/v5.7.html
https://notepad-plus-plus.org/download/v5.6.8.html
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https://notepad-plus-plus.org/download/v5.4.4.html
https://notepad-plus-plus.org/download/v5.4.3.html
https://notepad-plus-plus.org/download/v5.4.2.html
https://notepad-plus-plus.org/download/v5.4.1.html
https://notepad-plus-plus.org/download/v5.4.html
https://notepad-plus-plus.org/download/v5.3.1.html
https://notepad-plus-plus.org/download/v5.3.html
https://notepad-plus-plus.org/download/v5.2.html
https://notepad-plus-plus.org/download/v5.1.4.html
https://notepad-plus-plus.org/download/v5.1.3.html
https://notepad-plus-plus.org/download/v5.1.2.html
https://notepad-plus-plus.org/download/v5.1.1.html


Version Date de sortie

Version 5.1 2008-10-25

Version 5.0.3 2008-08-03

Version 5.0.2 2008-07-21

Version 5.0 2008-07-06

Version 4.9.2 2008-05-11

Version 4.9.1 2008-05-04

Version 4.9 2008-05-01

Version 4.8.5 2008-04-11

Version 4.8.2 2008-03-09

Version 4.8.1 2008-03-02

Version 4.7.5 2008-01-14

Version 4.7.3 2008-01-07

Version 4.7.2 2008-01-03

Version 4.7.1 2008-01-02

Version 4.6 2007-11-21

Version 4.5 2007-10-25

Version 4.4 2007-10-14

Version 4.3 2007-09-23

Version 4.2.2 2007-08-15

Version 4.1.2 2007-05-20

Version 4.1.1 2007-05-13

Version 4.1 2007-05-01

Version 4.0.2 2007-02-15

Version 4.0.1 2007-02-04

Version 4.0 2007-01-29
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https://notepad-plus-plus.org/download/v4.2.2.html
https://notepad-plus-plus.org/download/v4.1.2.html
https://notepad-plus-plus.org/download/v4.1.1.html
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https://notepad-plus-plus.org/download/v4.0.1.html
https://notepad-plus-plus.org/download/v4.0.html


Version Date de sortie

Version 3.9 2006-10-04

Version 3.8 2006-07-23

Version 3.7 2006-06-27

Version 3.6 2006-05-13

Version 3.5 2006-03-02

Version 3.4 2006-01-02

Version 3.3 2005-11-16

Version 3.2 2005-09-03

Version 3.1 2005-07-17

Version 3.0 2005-06-13

Version 2.9 2005-04-02

Version 2.8 2005-03-04

Version 2.7 2005-01-27

Version 2.6 2004-11-29

Version 2.4 2004-09-26

Version 2.3 2004-08-08

Version 2.2 2004-07-08

Version 2.1 2004-05-09

Version 2.0 2004-04-22

Version 1.9 2004-04-08

Version 1.8 2004-03-27

Version 1.7 2004-03-27

Version 1.6 2004-02-11

Version 1.5 2004-01-18

Version 1.4 2004-01-11
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Version Date de sortie

Version 1.3 2004-01-04

Version 1.2 2003-12-27

Version 1.1 2003-12-16

Version 1.0 2003-11-25

Examples

Installation ou configuration

Notepad ++ peut être installé:

À partir du programme d'installation téléchargé depuis le site Web du projet•
De Ninite, qui téléchargerait et installerait automatiquement la dernière version disponible: 
https://ninite.com/notepadplusplus/

•

Construit à partir de sources disponibles dans le GitHub Repo de ce projet.•

Lire Démarrer avec notepad ++ en ligne: 
https://riptutorial.com/fr/notepadplusplus/topic/2940/demarrer-avec-notepad-plusplus
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Chapitre 2: Auto-complétion et suggestion

Examples

Paramètres de base de l'auto-complétion et des suggestions

Notepad ++ fournit 2 types de fonctionnalités pour l'auto-complétion et des suggestions:

Achèvement automatique qui lit le fichier ouvert et fournit des suggestions de mots et / ou de 
fonctions dans le fichier

•

Suggestion avec les arguments des fonctions (spécifiques à la langue)•

Pour l'activer, vous devez modifier un paramètre.

Allez dans Settings > Preferences... > Auto-completion1. 
Cochez Enable Auto-completion on each input2. 
Sélectionnez le type d'achèvement souhaité:

mots seulement•
nom des fonctions uniquement•
les deux•

3. 

Si vous le souhaitez, cochez la Function parameter hint on input pour afficher les paramètres 
lors de la saisie d’un nom de fonction (cf. image ci-dessous).

4. 

Pour l'utiliser, commencez à taper un mot ou une fonction et après le nombre de caractères que 
vous avez spécifié, les suggestions apparaîtront:
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Une documentation sur l'auto-complétion est disponible ici: http://docs.notepad-plus-
plus.org/index.php/Auto_Completion

Personnalisation de la suggestion de langage (indice de paramètre de 
fonction)

Les indicateurs de paramètres peuvent être personnalisés par l'utilisateur, comme indiqué dans ce 
lien: http://docs.notepad-plus-
plus.org/index.php/Auto_Completion#How_to_create_keyword_auto-completion_definition_files

Comment créer des fichiers de définition de saisie automatique des mots clés

Depuis la version 5.0, Notepad ++ prend en charge les «Calltips» et introduit une 
nouvelle méthode de stockage des données de saisie semi-automatique. Maintenant, 
tout est stocké au format XML, ce qui permet une extension facile des fonctionnalités. 
Ce faisant, les données de saisie semi-automatique et d’aiguille sont combinées dans 
un seul fichier. Les fichiers texte plus anciens .api ne sont plus utilisés par Notepad ++ 
et peuvent être supprimés en toute sécurité s'ils sont présents.

Vous pouvez choisir le niveau de complétion automatique souhaité, à partir de Settings 
-> Preferences -> Auto Completion -> Enable Auto-completion sur chaque entrée: mots 
du document en cours, fonctions de la langue en cours ou les deux.

Les fichiers de saisie semi-automatique se trouvent dans le dossier "plugins \ APIs", 
qui se trouve dans le dossier d'installation de Notepad ++, le plus souvent C:\Program 
Files\Notepad++ .

La syntaxe des fichiers de saisie semi-automatique est simple, mais comporte 
quelques règles, notamment la syntaxe correcte et le tri approprié. Si la syntaxe est 
incorrecte, le fichier XML ne sera pas chargé et la saisie semi-automatique sera 
désactivée. Une description plus formelle peut être trouvée à l' édition des fichiers 
d'achèvement automatique .

Un tri incorrect (voir ci-dessous) peut entraîner un comportement erratique de la 
fonction de saisie semi-automatique, entraînant son échec sur certains mots.

Le jeu de caractères de base utilisé pour reconnaître les mots-clés est constitué de 
lettres ( az , AZ , 0-9 chiffres et le underscore ). [...]

<?xml version="1.0" encoding="Windows-1252" ?> 
<NotepadPlus> 
   <AutoComplete language="C++"> 
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       <Environment ignoreCase="no" startFunc="(" stopFunc=")" paramSeparator="," terminal=";" 
additionalWordChar = "."/> 
       <KeyWord name="abs" func="yes"> 
           <Overload retVal="int" descr="Returns absolute value of given integer"> 
               <Param name="int number" /> 
           </Overload> 
       </KeyWord> 
   </AutoComplete> 
</NotepadPlus>

Un petit exemple de la façon dont le fichier XML est construit est donné ci-dessus. 
NotepadPlus, AutoComplete et Environment sont des éléments singleton, il ne doit y 
en avoir qu'un, chacun devant être correct, bien qu'il soit permis de supprimer 
l'élément <Environment> . Faire ainsi toutes les valeurs par défaut à celles données 
dans l'exemple ci-dessus.

Pour les mots-clés qui ne sont pas des fonctions, la balise Keyword est en cours 
d'autoclivage et n'a que l'attribut name . Pour indiquer qu'un mot-clé peut être affiché 
dans une info-bulle, ajoutez l'attribut func à la valeur yes . Dans ce cas, la balise 
Keyword est un nœud et contient d'autres balises.

Ensuite, pour chaque surcharge de la fonction, un élément Overload doit être ajouté, 
qui spécifie le comportement et les paramètres de la fonction. Une fonction doit avoir 
au moins une surcharge ou elle ne sera pas affichée comme un appel. L'attribut retVal 
doit être présent et spécifie le type de la valeur de retour, mais l'attribut descr est 
facultatif et décrit le comportement des fonctions, comme un commentaire.

Vous pouvez ajouter des nouvelles lignes dans la description si vous le souhaitez. 
Pour chaque paramètre pris par la fonction, un élément Param peut être ajouté. L'attribut 
name doit être présent et spécifie le type des paramètres et / ou tout nom du paramètre.

Dans l'élément AutoComplete , vous pouvez ajouter l'attribut language mais il n'est pas 
utilisé par Notepad ++, vous pouvez l'ajouter si vous le souhaitez et vous pouvez 
prendre n'importe quelle chaîne.

Lire Auto-complétion et suggestion en ligne: 
https://riptutorial.com/fr/notepadplusplus/topic/4843/auto-completion-et-suggestion
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Chapitre 3: Fonctions d'édition avancées

Examples

Multi-édition

Multi-Editing permet à l'utilisateur de modifier du texte à plusieurs endroits simultanément.

Multi-Editing est désactivé par défaut: il peut être activé (resp. Désactivé) dans Preferences > 
Editing en cochant (resp. Décochant) la case correspondante.
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Pour utiliser Multi-édition, l'utilisateur peut CTRL - clic sur les différents endroits et commencer à 
taper.

Pendant l'utilisation de Multi-Editing, le texte peut être collé (par exemple en utilisant Ctrl + V ).

L'utilisateur peut également ajouter des nombres incrémentiels comme suit:

Allez dans Edit > Column Mode ( Alt + C )1. 
Sélectionner un Number to insert2. 
Choisissez le numéro de départ (par exemple 1 ), l'incrément (par exemple 1 ) et 
éventuellement un numéro de répétition (par exemple 2 pour avoir la séquence suivante 1 1 
2 2 3 3 ... )

3. 

Édition de colonne

L'édition de colonne permet à l'utilisateur de modifier le texte sur plusieurs lignes sous la forme 
d'une zone carrée verticale.

Cette fonction est activée par défaut.

Il y a 3 façons de sélectionner une zone à éditer:

Maintenez Alt + Maj et utilisez Haut / Bas / Gauche / Droite pour sélectionner la zone à éditer 
avec les touches de direction

•

Maintenez Alt + Maj et cliquez sur le document pour définir l'autre coin de la zone (le premier 
coin étant la position du curseur d'édition)

•

Alt + sélectionne la zone à éditer avec la souris tout en maintenant Click•
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Pour modifier le texte, vous pouvez

Tapez le nouveau texte•
Coller•
En utilisant Edit > Column Mode•

.

Par exemple, pour ajouter des nombres incrémentiels

Définir une zone avec les numéros à remplacer1. 
Edit > Column Mode > Number to insert et sélectionner les paramètres2. 

Lire Fonctions d'édition avancées en ligne: 
https://riptutorial.com/fr/notepadplusplus/topic/5047/fonctions-d-edition-avancees
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Chapitre 4: Plugins utiles pour les 
développeurs

Examples

NppExec

NppExec [ sourceforge ] vous permet d'exécuter des commandes et des scripts depuis une 
fenêtre de console dans Notepad ++. Vous pouvez le trouver dans la barre de menus de Plugins -
> NppExec ou simplement en appuyant simplement sur la touche F6 (le raccourci Ctrl + F6 
exécutera la dernière commande).

Exemple: le suivant sera

Définissez la console sur output_var: on , ce qui signifie que nous pouvons utiliser la sortie 
de la console

•

exécuter une requête SQL à partir du fichier C:\scripts\query.sql•
prendre la sortie de la console et la placer dans le fichier actif au niveau du curseur•
ferme la console•
effacer la console•

NPE_CONSOLE v+ 
sqlcmd -S 111.111.1.1 -U UserName -P "password" -i C:\scripts\query.sql 
sel_settext $(OUTPUT) 
NPP_CONSOLE 0 
cls

NppExec vous permet également de sauvegarder vos scripts. Après les avoir sauvegardés, vous 
pouvez accéder à Plugins -> NppExec -> Advanced Options et les exécuter à tout moment. Notepad 
++ démarre, ferme ou même ajoute ce script aux commandes du plug-in à l'aide de macros. Par 
exemple, en enregistrant l'exemple ci-dessus en tant que "Exécuter la requête", je pourrais utiliser 
les champs en bas à gauche des Options avancées pour l'ajouter au menu.
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Le script sera disponible sous forme de macro après le redémarrage de Notepad ++ tant que la 
case "Placer dans le sous-menu Macros" est cochée.

Enfin, un raccourci peut être attribué à la macro / commande en utilisant Settings -> Shortcut 
mapper -> Plugin commands .

TextFX

TextFX [ SourceForge ] est un plug-in pour les conversions de caractères avancées (caractères 
d'échappement, etc.) et le formatage du code (code HTML ou C ++).

JSON Viewer

JSON Viewer SourceForge est un plugin pour la visualisation et le formatage JSON. Il est utile 
pour mettre en retrait / formater des documents JSON et peut être utilisé pour parcourir un fichier 
JSON complexe à l'aide d'un outil d'arborescence.

L'image suivante montre les commandes offertes par le plugin:

A partir d'un fragment JSON non formaté (exemple de http://www.json.org ):
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{"glossaire": {"titre": "exemple de glossaire", "GlossDiv": {"titre": "S", "GlossList": 
{"GlossEntry": {"ID": "SGML", "SortAs": "SGML", "GlossTerm": "Langage de balisage 
généralisé standard", "Acronyme": "SGML", "Abbrev": "ISO 8879: 1986", "GlossDef": 
{"para": "Un langage de méta-balisage, utilisé pour créer des langages de balisage tels 
que DocBook. "," GlossSeeAlso ": [" GML "," XML "]}," GlossSee ":" balisage "}}}}}

Pour formater et indenter le code:

sélectionner tout le fragment json•
cliquez sur "Plugins" / "JSON Viewer" / "Format JSON" ou utilisez le raccourci Ctrl + Alt + 
Shift + M

•

Ceci est le code formaté résultant:

Le plug-in peut également afficher une version du fragment JSON navigable dans l'arborescence:

sélectionner tout le fragment json•
cliquez sur "Plugins" / "JSON Viewer" / "Afficher JSON Viewer" ou utilisez le raccourci Ctrl + 
Alt + Shift + J

•
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La capture d'écran suivante montre comment le plugin rend la structure JSON:

SourceCookifier

SourceCookifier analyse le code source actuel pour des composants tels que les noms de classe, 
de fonction et de variable et les affiche dans une vue arborescente sur un panneau latéral. La 
navigation parmi ces membres est possible en double-cliquant sur le nom du composant. Le plug-
in prend en charge un certain nombre de langues et des personnalisations sont possibles pour les 
langages indéterminés ou définis par l'utilisateur. Ceci est utile lorsque vous travaillez avec des 
codes volumineux.
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Par défaut, le mode de session SourceCookifier est défini sur Single file mode . Les autres 
modes disponibles sont le N++ session mode (tous les fichiers ouverts dans Notepad ++) ou le 
Cookie session mode .

Pour utiliser le Cookie session mode :

Faites glisser et déposez vos dossiers avec le code source dans la fenêtre Source Cookifier1. 

Sélectionnez le type de fichiers que vous souhaitez analyser2. 
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Remarques:

Vous pouvez enregistrer et charger les sessions de cookies; de plus, Source Cookifier 
affiche l'historique des dernières sessions

•

L'ouverture du fichier d'une session enregistrée dans Notepad ++ basculera 
automatiquement le SourceCookifier en mode session de cookie et chargera cette session

•

Le maintien d'un modificateur de clavier ( CTRL , SHIFT ou ALT - ils sont tous similaires) 
pendant le glisser-déposer du dossier accélérera l'analyse en ajoutant uniquement 
INCLUDES et non des balises

•

Une autre fonctionnalité utile est la possibilité de sauter à la définition d'un symbole (par 
exemple, fonction)

Sélectionnez le bon "mode de session": utilisez le mode cookie si la définition du symbole se 
trouve dans un autre fichier non ouvert dans Notepadd ++, ou en mode fichier unique si la 
définition est dans le même fichier

1. 

Dans Notepad ++, placez le curseur dans la fonction / le type dont vous souhaitez obtenir la 
définition et appuyez sur CTRL + MAJ + ENTRÉE pour accéder à la définition. S'il y a plusieurs 
définitions, vous pouvez choisir le fichier que vous voulez ouvrir

2. 
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Vous pouvez appuyer sur ALT + GAUCHE pour revenir à l'emplacement précédent (et ALT + 
DROITE pour revenir à la définition)

3. 

Lire Plugins utiles pour les développeurs en ligne: 
https://riptutorial.com/fr/notepadplusplus/topic/3677/plugins-utiles-pour-les-developpeurs
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Chapitre 5: Regex

Examples

Référencement des groupes de capture

Des références

Les "backreferences" sont des références dans une expression régulière de recherche pour 
capturer des groupes dans la même expression régulière. La "regex de recherche" est 
l'expression régulière utilisée dans le champ "Rechercher" de la boîte de dialogue Rechercher / 
Remplacer. Voici la syntaxe de référence la plus courante:

Absolute:  (group one)...\1 
 
Relative:  (group one)(group two)...\-1 
 
Named:     (?<name>group)...\k<name>

Substitutions

Les "substitutions" sont des références dans une expression rationnelle de remplacement pour 
capturer des groupes dans le regex de recherche associé. La "regex de remplacement" est 
l'expression régulière utilisée dans le champ "Remplacer" de la boîte de dialogue Rechercher / 
Remplacer. Voici la syntaxe de substitution la plus courante:

Absolute:  $1 
 
Named:     $+{name}

Plus de 9 groupes

Les formats \1 , \-1 et $n sont des nombres à un seul chiffre limités. Pour référencer un groupe de 
capture supérieur à neuf, utilisez plutôt la syntaxe suivante:

Backreference:  (group one)...(group ten)...\g{10} 
 
Substitution:   ${10}

Groupes de capture

Une expression régulière dans Notepad ++ peut contenir autant de groupes de capture que vous 
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le souhaitez.

(one)(two)(three)...(nine)(more than nine groups!)...

Les groupes de capture anonymes utilisent la syntaxe standard:

(group)

Les groupes de capture nommés peuvent utiliser l'un des formats de syntaxe suivants:

(?<name>group) 
 
(?'name'group)

Les groupes de capture anonymes et nommés peuvent être mélangés dans n'importe quel ordre:

(anonymous)(?<name>named)(anonymous)

Les groupes de capture sont numérotés à partir de 1 fonction de l'ordre de leur parenthèse 
d'ouverture ', quelle que soit l'imbrication:

((group 2) group 1)

Notez que les groupes nommés sont inclus dans la numérotation:

(group 1)(?<name>group 2)(group 3)

Lire Regex en ligne: https://riptutorial.com/fr/notepadplusplus/topic/8714/regex
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